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IMPORTANT

SYSTEM REQUIREMENTS

READ ALL INSTRUCTIONS carefully and com-

pletely before using the receiver.

SAVE THIS INSTRUCTION MANUAL — This

instruction manual contains important operating instructions
for the RS-R75 REMOTE CONTROL SOFTWARE.

USE antenna(s), such as a well-matched 50 Q antenna
and feedline. For radio communications, the antenna is of
critical importance, along with sensitivity.

CAUTIONS

AWARNING! NEVER connect the receiver to an AC
outlet. This may pose a fire hazard or result in an electric
shock.

NEVER connect other than the specified AC adapter to
the receiver. This connection will ruin the receiver.

NEVER connect the receiver to a power source of more
than 16 V DC such as a 24 V battery. This connection will
ruin the receiver.

NEVER expose the receiver to rain, snow or any liquids.

DO NOT use or place the receiver in areas with tempera-
tures below —10°C (+14°F) or above +60°C (+140°F) or, in
areas subject to direct sunlight.

AVOID placing the receiver in excessively dusty environ-
ments.

AVOID the use of chemical agents such as benzine or al-
cohol when cleaning, as they damage the receiver surfaces.

*|BM PC/AT compatible computer

*An RS-232C serial port

* Microsoft® Windows® 95 or Microsoft® Windows® 98

«Intel i486DX4 processor or faster (Pentium® 100 MHz or
faster recommended)

*Atleast 16 MB RAM

At least 10 MB of hard disk space

«At least 640 x 480 pixel, High color (16 bit) display (800 x
600 pixel display recommended)

OPERATING THEORY

Electromagnetic radiation which has frequencies of 30,000
Hz (30 kHz*) and above is called radio frequency (RF) en-
ergy because it is useful in radio transmissions. The IC-R75
receives RF energy from 0.03 MHz* to 60 MHz and converts
it into audio frequency (AF) energy which in turn actuates a
loudspeaker to create sound waves. AF energy is in the
range of 20 to 20,000 Hz.

*kHz is an abbreviation of kilohertz or 1000 hertz, MHz is abbrevia-
tion of megahertz or 1,000,000 hertz, where hertz is a unit of fre-
quency.

OPERATING NOTES

The IC-R75 may receive its own oscillated frequency, result-
ing in no reception or only noise reception, on some fre-
quencies.

The IC-R75 may receive interference from extremely strong
signals on different frequencies or when using an external
high-gain antenna.

IBM is registered trademark of International Business Machines Corporation in
the U.S.A. and other countries. Microsoft® and Windows® are registered trade-
marks of Microsoft Corporation in the U.S.A and other countries. Screen shots
produced with permission from Microsoft Corporation. All other products or
brands are registered trademarks or trademarks of their respective holders.
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SPECIAL NOTES

. As a general prerequisite American English is used.

When other languages are put into practice there
are cases where these messages can not be read.

2.The IC-R75 VFO/MEMO and the control software of

3.

VFO/MEMO can not be linked.

In the control software, the 'S-AM' does not blink.

4. With no relation to the IC-R75 filter selection, you

can select filters (W/N) on the control software, but
appropriate filter is automatically selected in some
cases.

. Because the scan methods of the IC-R75 and con-

trol software are different, the scan speed also dif-
fers.
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m Hardware installation

Refer to the diagram in the IC-R75 instruction manual p. 10
for connections.

RS-232C cable (OPC-743)

e R
200 © ””

Personal computer IC-R75

m Supplied accessories

@ @
RS-R75
Accessories included with the receiver: Qty.
(D RS-232C cable (OPC-743)  .....ovvviiieen.. 1
@ Software CD-ROM ... ..o oo 1 set




m Software installation

7 NOTE: Depending on the Windows® system files, the PC
7 may require rebooting. In this case, repeat the installation
é from the beginning.

< Installation

(D Boot up Windows.

«Quit all applications when windows is running.

@ Insert the RS-R75 CD-ROM into the appropriate CD-ROM
drive.

3 Select ‘Run’ from the [Start] menu.

@ Type the setup program name with full path name, then
press the [Enter] key. (D*:\RS_R75\disk1\Setup.exe
[Enter], * CD-ROM drive name may differ depending on setting)

® Following dialog appears. Follow the prompts.

Welcome E I

‘Welcome to the RS-R75 Setup pragram.  This
program will install BS-R75 on your computer,

It iz strongly recammended that pou exit all Windows programs
betore running this Setup program.

Click Cancel ta quit Setup and then claze any programs you
have unning. Click Mexst to continue with the Setup program.

‘WaRNIMG: This program is protected by copyright law and
intemnational treaties.

Unauthorized reproduction o distribution of this program, or any
portion of it, may result in severe civil and eriminal penalties, and
will be prozecuted to the maximum extent possible under law.

T Cancel |

(® Program group ‘Rs-r75’ appears in the ‘Programs’ folder
of the [Start] menu.

(B8 icPoRioo

Accessories
C3-2800

Ca481

Icom FS-746
IC-PCR100
Microsoft Hardware

Startlp

wee
B 1i5-00S Frompt
@ ‘windows Explarer

< Software update information
Software update information will be available at the lcom
America home page:

http://www.icomamerica.com/

INSTALLATION 1

m COM (RS-232C) port settings

‘COM ERR’ or ‘Can not open port. Already open?’ dialog box
appears when the RS-232C serial port is not set correctly.

7, NOTE: When launching the program for the first time, this
/ setting dialog appears for the setting of RS-232C serial

é port.

< Port setting

(D Before launching the program, make sure the RS-232C
cable is connected correctly.

(@ Launch the RS-R75 software.

3 Click the [POWER] button in the tool bar or on the front
panel.

@ Click the [Options] button then select ‘Port setting’ in the
menu to bring up the [CommSettings] dialog box.

® Click and select the desired COM port number.

(® Set the data transfer rate according to the connected PC's
port speed.

(@ Set 'Receiver (CI-V) address' if the other address is se-
lected on connected IC-R75. (default; 5A)

Click the [OK] button.

=l 2
% Comm settings E3 |

— Communication port

Port Murmber

TR -

Speed [19200 =l

— Receiver

|5,é., [Hex]
Ok | Cancel |

Receiver addresz

m Mouse property setting

The RS-R75 uses left and right buttons to rotate a control
knob on the receiver screen or to call up the shortcut menu.
Depending on the mouse property setting of the control
panel, main and sub mouse button functions are alternated.

7 In this instruction manual, the operation is described with
7, setting for right-handed (Windows® default setting).

< Setting the button configuration

(D Select ‘Settings’ from the [Start] menu and click ‘Control
Panel

(2 Open the mouse control panel.

(3 Select the button configuration to right- or left-handed.

@ Click [OK] to set and exit the control panel.
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PANEL DESCRIPTION

m Front panel
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@ POWER SWITCH [POWER]
Toggles the receiver power ON and OFF.

@ FILE MENU [File]
Used for turning OFF the software.

© MEMORY BANKS BUTTON
Click to display the “Memory Bank” screen.

O VIEW MENU [View]
Used for showing the “Memory bank” screen, “Band
scope” screen and “Scan manager” screen.

@ BAND SCOPE BUTTON
Push to display the “Scope manager” screen.

@ MEMORY CHANNEL SELECT MENU [Channels]
Used for selecting the memory channel number directory.

@ SCAN MANAGER BUTTON
Push to display the “Scan manager” screen.

© RECEIVER SETTING BUTTON
Click to indicate the receiver settings menu.
0 General, Sound and Display menu are available. (p. 15)

© TUNING STEP SELECTION [Tuning Step]
Click to indicate the tuning step selection menu. Available
tuning steps for selection as follows;
1 Hz, 10 Hz, 100Hz, 1KHz, 5 KHz, 6.25 KHz, 9 KHz, 10
KHz, 12.5 KHz, 20 KHz, 25 KHz, 100 KHz, 1 MHz.

@ AF MUTE BUTTON [Mute]
Push to turn the audio mute function ON and OFF.

® TOOLTIPS BUTTON
Push to turn the tooltips ON and OFF.

n nnn
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(® [Options]
Click the [Options] to bring up the “Receiver settings”,
“Port settings” and “Tooltips” screen.

® HELP [Help]
Click to bring up the Help contents, click menu to call Icom
home pages and software version number or copyright.

® MODE SELECT BUTTON

O Click [SSB] to toggle USB or LSB mode.

O Click [CW RTTY] to toggle CW or RTTY mode, click
and hold [CW RTTY] for 1 sec. to toggle reverse [REV]
mode on ON and OFF

O Click [AM] to toggle AM or S-AM* mode.

O Click [FM] to select FM mode.

® IF FILTER SELECT BUTTON
Click to select the IF narrow filter or wide filter. (Optional IF
filters required in some cases.)
*Usable IF filters vary according to receive mode.

@® TUNING STEP SELECT BUTTON
Left click to toggle TS steps.
*Right-click* to display the TS selection menu, select desired tun-
ing steps if necessary.

® CLOSE BUTTON
Push to quit and exit the software.

® KEY PAD [0]-[9], [*], [ENT] (p.6)
[ [O] to [9] are used to input a received frequency directly.
O[] (Decimal) button is used to set the MHz digit when
inputting a frequency.
O [ENT] (Enter) button is used to set the input frequency.



® MEMORY WRITE [MW]
Push [MW] to program the displayed frequency, operating
mode and filter width into the memory channel.

@ CLEAR INPUT [CLR]
O Click [CLR] when a key is mistakenly pushed.
O Push and hold 1 sec. to clear all memory contents
when memory mode is selected.

@ VFO/MEMORY KEY [V/M]
Push to toggle between VFO and memory modes.

@ SCAN [SCAN] (p. 12)
Push to turn the “Scan manager” screen ON.

@ MEMORY CHANNEL UP BUTTON [UP A]
O Right-click* to increase the memory channel number.
O Left-click* to bring up memory channel list screen to se-
lect the previous channel.

@ AUTO SQUELCH [A.SQL]
Automatically sets the squelch level to the threshold point.

@ MEMORY CHANNEL DOWN BUTTON [ VDN]
O Right-click* to decrease the memory channel number.
O Left-click* to bring up memory channel list screen to se-
lect the previous channel.

@ TUNING DIAL
Push to set the receive frequency with the selected tun-
ing step.
*Right-click* to increase the frequency; left-click to decrease the
frequency.

@ ANTENNA SELECTER [ANT]
Push to select [ANT 1] or [ANT 2].

@ CLOCK BUTTON [CLK]
Push to display the actual time.

@ AGC SWITCH [AGC] (p. 8)
Push momentarily to cycle through the AGC time con-
stants:
[OFF] O [AGC] O [FAGC]

€ TWIN PBT(p. 7)
Shift the center frequency of receiver’s IF passband.
*Right-click to shift the center frequency higher, or left-
click to shift the center frequency lower.

€D NOISE BLANKER SWITCH [NB] (p. 8)
Push to activate the noise blanker function.
*The noise blanker is used for removing pulse-type noise when
SSB, CW or AM mode is selected.

€ AUTOMATIC NOTCH FILTER SWITCH [ANF] (p. 8)
(Optional UT-106 DSP UNIT is required)
Push to toggle the automatic notch filter function ON and
OFF.
*The automatic notch filter automatically attenuates beat tones,
tuning signals, etc., even if they are moving. The automatic notch
filter functions in SSB, FM and AM modes.

€ RF GAIN CONTROL/SQUELCH CONTROL [RF/SQL]

(p.-7)
O Adjusts the squelch threshold level (to mute noise when

PANEL DESCRIPTION 2

receiving no signal) in all modes.

O This control can be used for RF gain control to adjust
receiver gain manually.

*RF gain selection can be set in Receiver Settings screen.

*RF gain is usable in SSB/CW/RTTY modes only.

€@ NOISE REDUCTION [NR] (Optional UT-106 DSP UNIT

is required)

Push to toggle the noise reduction function ON and OFF.
The noise reduction function reduces noise components
and picks out desired signals which are buried in noise.
The received AG signals are converted to digital signals
and then the desired signals are separated from the
noise. The noise reduction functions in all modes.

€ AF CONTROL
Adjust the audio output.
*Right-click* to increase the volume level; left-click* to decrease
the volume level.

€ ATTENUATOR [ATT]
The attenuator prevents desired signals from distorting
when other strong signals are near the desired frequency
or when very strong electric fields, such as from broad-
casting stations, are near your location.
¢ Push to turn the 20 dB attenuator ON and OFF.

€@ PREAMP SWITCH [AMP]
The preamp amplifies received signals in the front end cir-
cuit to improve the S/N ratio and sensitivity. Turn this func-
tion ON when receiving weak signals.
¢ Push to turn the [PREAMP 1] or [PREAMP 2] ON or OFF.

€@ POWER SWITCH [POWER]
Toggles the receiver power ON and OFF.

* When the mouse property is set for right-handed.




2 PANEL DESCRIPTION

m Function display
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@ IF WIDE/NARROW FILTER INDICATOR [WJ/[N]
Indicates the selected IF filter and signal passband width.

@ RX REVERSE INDICATOR [REV]
Indicates the reverse mode (CW and RTTY modes only)
being selected.

© PROGRAMMABLE/1 MHz TUNING STEP INDICATORS
U @a appears when the 1 MHz tuning step is selected.
O @b appears when the programmable tuning step is se-
lected.
O RECEIVE MODE INDICATORS
Indicates the current receive mode.

@ BUSY INDICATOR [RX]
Appears when receiving a signal or when signal noise
opens the squelch.

@ TUNING STEP INDICATOR
This is the frequency increment used when selecting a
frequency using the tuning dial and when searching for
signals using a scan function.

@ FREQUENCY INDICATION
Indicates the receive frequency or internal clock time.

© BLANK INDICATOR [BLANK]
Appears when the displayed memory channel has no con-
tents.

© MEMORY CHANNEL NUMBER READOUT
Shows the selected memory channel number.
'S’ reveals that the displayed memory channel is designated as
a select memory channel.
«Comment appears at the right of channel number when a com-
ment has been preprogrammed in the memory bank.

@ VFO/MEMORY INDICATOR [VFO/MEMO]
Indicates the memory bank number (and its name if it has
one) being received.

® AGC INDICATOR [F.AGC/OFF]
Shows the time constant of the AGC circuit.

6
o

_______________

@ NOISE BLANKER INDICATOR
Appears when the noise blanker is activated.

® ANTENNA INDICATOR [ANT 1/2]
Indicates the selected antenna number.

O ATTENUATOR INDICATOR [ATT]
Appears when the attenuator function is on.

® PREAMP INDICATOR [PREAMP 1/2]
Appears when the attenuator function is on.

® S (SIGNAL) METER
Indicates the receive signal strength. Also indicates the
S-meter squelch receive level set via the [SQUELCH] con-
trol.

® DSP/ANF/NR INDICATOR (OPTIONAL UT-106 is required)

[0 [DSP] appears when the optional DSP unit is installed.

O [ANF] appears when the ANF (Automatic Notch Filter)
function is turned ON.

O [NR] appears when the NR (Noise Reduction) function is
turned ON.



m Receiving

Make sure the hardware installation is finished. (p. 1)

< Using the multi-function receiver screen

(@ Click [POWER] to turn power ON.

@ Click the [VOLUME] control with the sub mouse button to
increase the audio level; click the [VOLUME] control with
the main mouse button to decrease the audio level.
*When clicking and holding the control, the audio level scrolls up

or down.

(3 Set an operating frequency and mode. (p. 3)

@ Click the [SQUELCH] control with the sub mouse button to
increase the squelch level (tight squelch); click the
[SQUELCH] control with the main mouse button to de-
crease the squelch level (loose squelch).

*When clicking and holding the control, the squelch level scrolls
up or down.

(® When a signal is received:

(3 Select mode

Power switch

Set volume Set frequency

Set the squelch level

0 Squelch opens and audio is emitted from the speaker.
0 The S-meter shows the relative signal strength.

BASIC OPERATION

m Setting a frequency

Depending on the situation, the receive frequency can be set
using the following methods. Frequencies can be set from
30.000 KHz to 60.000000 MHz.

< Using the tuning dial
O Click the tuning dial with the sub mouse button to increase
the frequency; click the tuning dial with the main mouse
button to decrease the frequency.
*The frequency changes according to the preset tuning steps.
See the next page for selecting the tuning step.
*When clicking and holding either button the frequency scrolls up
or down.

< Using the keypad
O Click the desired numeral buttons, then click [ENT] to set
the frequency.
*When making a mistake while inputting a frequency, click [CE] to
clear the input and return to the previous frequency.
*When you want to change the 100 kHz digit and below, click [¢]
first, then the numeral buttons and then [ENT].
*When you want to set the 100 kHz digit and below to 0, input
the MHz digits and then click [ENT].
*When inputting a frequency outside of the allowed receive fre-
guency range, the previously selected frequency is automatically
selected after clicking [ENT].

< Using the PC keyboard
O Push the desired numeral keys, then push [Enter] to set
the frequency.
«When inputting from the keyboard, click anywhere in the re-
ceiver screen first, then begin inputting from the keyboard.
*When making a mistake while inputting a frequency, push [Esc]
to clear the input and return to the previous frequency.
*When you want to change the 100 kHz digit and below, push [¢]
first, then the numeral keys and then [Enter].
«When you want to set the 100 kHz digit and below to 0, input
the MHz digits and then push [Enter].
«Push [4=] or [=] to set the frequency according to the selected
tuning step.
*When inputting a frequency outside of the allowed receive fre-
quency range, the previously selected frequency is automatically
selected after clicking [Enter].

3



3 BASIC OPERATION

m Setting a tuning step

When using the tuning dial to change the frequency, or when
a scan function is activated, the frequency changes in incre-
ments determined by the set tuning step. This can be
changed if desired.

The following tuning steps are available.

*1Hz *10Hz *100Hz <1kHz <5kHz +6.25kHz
*9kHz *10kHz *125kHz*20kHz <25kHz <100 kHz
*1 MHz

< Using the [TS] switch
0 Click [TS] to set the desired tuning step.
*The selected tuning step is displayed in the function display.

< Using the function menu
(D Push the PC's [Alt] and select the ‘“Tuning Step’ then push
[Enter].
(2 Push the [1] or [#] key to select the desired tuning step.
*The selected tuning step is displayed in the information display if
this is in use.

m Receive mode selection

Receive modes are determined by the physical properties of
the radio signals. The receiver has 9 receive modes: FM, AM
S-AM, LSB, USB, CW, CW-R, RTTY and RTTY-R modes.

Typically, AM mode is used for the AM broadcast stations
(0.495-1.620 MHz), and FM is used for 28 MHz/50 MHz FM
stations.

< Using the [SSB],[CW RTTY],[AM] or [FM]
buttons.
O Click [SSB], [CW RTTY], [AM] or [FM] momentarily to se-
lect the desired receive mode.
«Click and hold for 1 sec to select reverse mode. [R] appears on
the display.

m RF gain and squelch

The RS-R75 uses the same control [RF/SQL], to adjust one
of either the RF gain or the squelch.

[RF/SQL] adjusts either the RF gain or the squelch depend-
ing on the operating mode selected and the condition of the
RF gain item in “Receiver Settings” in the Options menu. (p. 15)

The RF (Radio Frequency) gain is used to adjust the receiver
gain.
*This control should be set to the 11 o’clock position for normal
use.

«Shallow rotation moves the S-meter to the follow indicating the
signal strength which can be received.

The SQUELCH removes noise output from the speaker (closed con-
dition) when no signal is received. The squelch is particularly effec-
tive for FM. It is also available for the other modes.

*«When operating in FM, first rotate the control fully counterclock-
wise. Then, rotate the control clockwise to the point where the
noise just disappears. This is the best position. The squelch
does not open for weak signals when it is set too deep.

*A segment appears in the S-meter to indicate the S-meter

squelch level.
Set mode USB, LSB, )
setting CW, RTTY AM, S-AM, FM

Sq (SQL) SQL* SQL*
At (AUTO) RF GAIN SQL*
rS (RF/SQL) RF/SQL RF/SQL

! S-met Ich
m?é%%g%usgcﬁt\‘ thrig%rk?gg'fn% Max. RF gain position

Squelch

opens & j

Yy
RF gain Same effect as at
decreases  the center position

m TWIN PBT

The PBT function electronically narrows the receiver’s IF
passband widths to reduce interference. Moving both [TWIN
PBT] controls to the same position shifts the IF.
O Click the [TWIN PBT] controls to adjust this function.
*[TWIN PBT] should normally be set to the center positions when
there is no interference.
«When PBT is used, the audio tone may change.
«PBT may not function with some filter combinations.
*Not available in FM mode.

m |F filter [FIL] selection

Increasing or decreasing the width of incoming signals can

help eliminate interference. Available filters vary according to

the receive mode.

< Using the [FIL] button

O Click the [FIL] buttons momentarily to select narrow;[N] fil-
ter, wide;[W] filter or standard widths.



m Attenuator function [ATT]

Strong signals (such as from broadcast stations, pocket
beepers, nearby amateur radio stations, etc.) can cause dis-
tortion of received signals. The attenuator function can re-
duce strength of interfering signals by approx. 20 dB.

< Using the [ATT] button
0 Click [ATT] to toggle the attenuator function ON and OFF.
«“ATT” appears in the function display.

m Noise blanker function [NB]

The noise blanker reduces pulse-type noise such as that generated
by automobile ignition systems. This function is not effective for FM
modes or for non pulse-type noise.
O Click [NB] to toggle the noise blanker function ON and
OFF.
*“NB” appears in the function display.

m AGC time constant

The AGC (Automatic Gain Control) controls receiver gains to pro-
duce a constant audio output level even when the received signal
strength is varied by fading, etc. Use AGC slow for normal phone op-
eration; AGC fast for receiving data and searching for signals. AGC
time constant cannot be changed in FM mode.

O Click [AGC] to toggle the AGC time constant between fast

and slow.
O Click and hold [AGC] to turn the AGC time constant OFF.

m Automatic Notch Filter [ANF]
function (UT-106 DSP unit
requires)

The automatic notch filter automatically attenuates beat
tones, tuning signals, etc. , even if they are moving. The au-
tomatic notch filter functions in SSB, FM and AM modes.
O Click the [ANF] buttons to toggle the automatic notch filter
function ON and OFF.
«“ANF” appear when the function is ON.

m Noise Reduction function
[NR] (UT-106 DSP unit requires)

The noise reduction function reduces noise components and
picks out desired signals which are buried in noise. The re-
ceived AF signals are converted to digital signals and then

BASIC OPERATION 3

the desired AF signals are separated from the noise. The
noise reduction functions in all modes.
O Left click the [NR] buttons to toggle the noise reduction
function ON and OFF.
*“NR” appear when the function is ON.
O Right click the [NR] buttons to display the noise reduction
level. Left click to set the noise reduction level.
*Level '0' means the function OFF.
*Set the control for maximum readability. High level results in
audio signal masking or distortion.

m Preamp function [AMP]

The preamp amplifiers receive signals in the front end circuit
to improve the S/N ratio and sensitivity. Turn this function ON
when receiving weak signals.
O Click the [AMP] buttons to toggle the preamp 1, preamp 2
and OFF.
*“PREAMP 1 (or 2)" appear when the function is ON.




4 MEMORY OPERATION

m General

One memory bank consists of 101 memory channels (99
normal memory channels + 2 scan edge channels) for stor-
age of often-used frequencies.

< Memory channel contents
The following information can be programmed into memory
channels:

*Select memory scan setting (p. 13)

*Operating frequency (p. 6)

*Receive mode (p. 3)

« Attenuator ON/OFF (p. 8)

*Preamp 1/2 or OFF (p. 8)

*Antenna connector 1/2

*Memory channel comment

m Saving memory banks

The memory banks can be stored as a PC file.

0 Select [Save] or [Save As] on the [File] menu to back up
memory channel data.

0 Select [Open] on the [File] menu to open memory channel
data.

0 Select [New] on the [File] menu to make a new file for
memory channel data.

Select memory channel (2) Select memory bank (® 'Upload' button
-
File | Edit Barklist Transfer
[Fe|rrs = RS E ER
CH{anl SEL |[FrEQ [mopE  [ATT [FamE [T COMMENT. ﬂ
oify 1.018MHz AM OFF PAZ ANT 2 asahi
0zv 9.76MHz AM OFF Pa1 ANT 1 Vioice Of America
03[ 7.385MHz AM OFF PA1 ANT 1 China Int. BC
04| 9.635MHz AM OFF PA1 ANT 1 Radio Japan
05| 7.48MHz AM OFF Pa1 ANT 1 Swiss Int BC
0B[N 9.71MHz AM OFF PA1 ANT 1 Radio Australia
o7
05
038 =l

m Selecting a memory channel

<© Using the [UP A] or [DN V] button on the
front panel

O Left click the [UPA] or [DN ¥] button to call the memory
list screen, then right click the desired memory channel
number.

O Right click to display the channel number cell, then left
click to select the desired item.

< Using the memory bank screen

(D Click the ‘Memory banks’ screen from the [View] menu if it
is not displayed.
«Or click the [Memory banks] button.

@ Click the ‘Bank list” and select the desired bank name.
Click again to select desired bank.

(3 Click the desired channel number and double click to set

the desired memory contents.
«Click the data area you want to call up, then double click to call
up the data.

< Send bank data to the receiver

O Click the ‘Write’ in the Transfer menu or push the ‘upload’
button to transfer the selected bank contents to the re-
ceiver.

< Read bank data to from receiver

O Click the ‘Read’ in the Transfer menu or push the ‘Down-
load’ button to transfer the selected bank contents from the
receiver.



m Memory channel programming

Each memory bank can hold up to 101 channels and can
store the information listed below.
Select memory scan setting [SEL], operating frequency
[FREQ], receive mode [MODE], IF  filter
narrow/wide[N]/[W], attenuator 20dB/OFF [ATT], preamp
1/2 or OFF [PAMP], antenna connector 1/2 [ANT], mem-
ory channel comment [COMMENT].

< Using the [UPA]or [DN V] on the frontpanel

(@ Click the [UPA] or [DN ¥] button to select a memory
channel to be programmed.

(@ Set a frequency and mode, etc. that you want to memo-
rize.

(3 Click the [MW] button to program the displayed frequency
into the memory channel.

< Using the ‘Memory bank’ screen
@ call up the ‘Memory banks’ screen if it is not displayed.
«Click the ‘Memory banks’ screen button or select ‘Memory
banks’ from the [View] menu.
(2 Click bank lists or select a bank name with [+ ] in order to
select a desired memory bank.
(3 Click a cell in the [FREQ] column and the desired memory
channel line.
@ Input the receive frequency from the keyboard, then push
[Enter].
«Input frequency first in order for other data to be input.
(® Set other data such as mode, tuning step, etc., if desired.
«Click the desired cell, select the desired item and double-click
the selection.

(3 Select desired cell ® Set other data, if desired
I [
File Edit Banklist Transfer
RSA75 =l 88| 3]s 22
CHAN SEL EES [mope — [aTm [FPAmP [anT COMMENT 4
il T g on neE o0 T2 acahi
027 9.76M 1z ‘AM QFF PA1 ANT 1 Woice O America ‘
03fr 7.385MHz AM OFF PA1 ANT 1 China Int. BC
04 9.695MHz AM OFF PA1 ANT 1 Radia Japan
05|y T 48MHz AM OFF PA1 ANT 1 Swiss Int. BG
OB 8.71MHZ AM OFF PA ANT 1 Radio Australia
o7
0g
03 =

MEMORY OPERATION 4

m Editing the memory bank list

< Editing a bank name
Bank names and memory comment can be set or changed
for the screen being used.

( Call up the ‘Memory banks’ screen if it is not displayed.

*Click the memory bank button or select ‘Memory banks’ from the
[View] menu.

(2 Click to select a bank name with [+ ] to allow selection of
a memory bank.

(3 Click the memory bank name indicator or a memory com-
ment cell on the ‘Memory banks’ screen.
*The memory bank name or memory comment is highlighted.

@ Input the name from the keyboard.
«Push [Enter] first to modify the previously input name.

(® Push the [Enter] key to input the name.

< Inserting and deleting channels

New blank channels can be inserted into the channel list and
channels no longer needed can be deleted from the channel
list.

(D call up the memory bank screen if it is not displayed.
*Click the memory bank screen button or select ‘Memory bank’
from the [View] menu.
(2 Select a desired bank name with [+ ] to allow selection of
a memory bank.
(3 Click the position where you want to insert/delete a chan-
nel.
@ Click ‘Insert’, ‘Remove’ or ‘Clear’ to insert, remove or clear
the channel at the selected position.
*When memory channel 99 is not a blank channel, a new blank
channel can not be inserted. Delete a channel or use another
memory bank in this case.

(3 Memory bank name Comment
A= £
Fiie | Edt Banklist Transfer
[Rs#75 = xR RE S B ED R )
CHAN 5 [FREQ [mope [ [FamE [AnT COM |[1ENT ii
[ 1.0 BhHz A OFF FAZ ANT 2 asall
0z 9.76MHz | AM OFF FA1 ANT A Woice 0T America
GEIC 7.385MHz A OFF PA1 ANTA China Int, BC
8|1 5.695MHz A OFF FA1 ANT A Radio Japan
[E 7.48MHz | An OFF PA1 ANT 1 Suiss Int, BC
[ 9.71MHz| AM OFF PA1 ANTA Radio Australia
07
[}
[} =l
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m Scan types

SCAN OPERATION

PROGRAMMED SCAN
(p- 12)

Scan edges

| I/ \I

‘x.Jump_,—'

Scan

Repeatedly scans between
two user-programmed fre-
guencies. Used for checking
for frequencies within a
specified range such as re-
peater output frequencies,
etc.

MEMORY SCAN
(p. 13)

Not yet
programmed

Repeatedly scans memory
channels within a memory
bank (1-99).

SELECT MEMORY SCAN
(p- 13)

Not yet
programmed

Repeatedly scans only select
memory channels within a
memory bank. This function
can be turned ON/OFF in
[Scan manager] tab. Select
channels can be set in the
memory list screen.

Up to 10 programmed scan ranges, memory scan, memory
select scan, memory skip scan, mode select memory scan
and auto memory write scan provide scanning versatility.




m Programmed scan

Programmed scan automatically searches for signals within
a specified frequency range.

7 For programmed scan, scan edges must be programmed
7 in advance. See the following section for details.

< Program the program scan edge channels

(D Click the desired program channel number cell, then enter
start frequency, end frequency, TS(tuning step), mode (IF
filter selection and CW RTTY reverse also available), at-
tenuator 20 dB or OFF, preamp 1, 2 or OFF, Antenna 1 or

2 and comments.

(2 Make sure the squelch is set to the threshold point.

(3 Click to select the desired programmable channel.

@ Click the [Start prog. scan] button to start programmed
scan.

(® To cancel the scan, click [Stop prog. scan].

*When the frequency is changed after canceling a scan and a
new scan is activated, scan starts from the starting frequency
of the specified frequency range. When the frequency is not
changed, scan starts from the previously stopped frequency.

% Scan manager [_[]x]
T59.0kHz 1.368MHz

1.008MHz 1.008MHz 1.782MHz

Fast Slow Mone 25 55 10s 15s 30s Stop

Praogram scan list
FR_[5TART__ [END [72_ |mope  Jatr  [FAMP [AnT [GOMMENT i’
01| 20.0kHz B0.OMHz  TkHz USE OFF  OFF  ANT1
02| 1.008MHz  2.0MHz|  SkHz AM OFF OFF ANT2
03
04
05
[
T :I
Stop piog. scan
Memory scan
’7 ™ Selected channels anly Start mem, scan |

m Setting scan edges

Settings such as frequency range, receive mode, tuning step,
etc. must be set in advance. Up to 10 settings can be pro-
grammed.

(D Ccall up the ‘Scan manager’ screen if it is not displayed.
«For the receiver screen, click the [SCAN] button.

«Click the ‘View” menu and select the ‘Scanner’.

(@ Click the desired program channel cell to edit the program
list.

(3 Click a start frequency cell in the [START] column to se-
lect the data input condition.

*When a cell is clicked, the scan edges of the line are automati-
cally set as scan edges.

@ Input the start frequency into the selected cell from the
keyboard, then push [Enter] (data appears automatically
in other cells when new range is entered.).

*Data must be set in this cell or the [END] cell before data can
be set in other cells.

SCAN OPERATION 5

m Scan resume condition

When receiving a signal, scan automatically pauses on that
signal. The scan resume condition sets the time that the scan
pauses before resuming or whether scan stops instead of
pausing.

Click the [Delay] bar, then click B
to select a resume condition.

Bz 10z 15z 30z Stop

0 None; scan does not stop
even if receiving a signal.
0 2S, 5S, 10S, 15S and 30S; scan resume on with adjusted
delay period
*When setting a time delay using the [Delay] control bar,
scan pauses when receiving a signal and then resumes
after the specified delay.
0 Stop; scan stop’
+When a signal is received during scan, scan stops and
does not resume.

m Scan speed setting

The searching speed of frequencies or memory channels is
variable.

O Click the [Speed] control bar with the main mouse button
to select the scan speed.
'SDeed

Fast 0 siow
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5 scaN OPERATION

m Memory scan

This function searches all memory channels in a selected
memory bank

(D Make sure the squelch is set to the threshold point.
(closed condition)

(2 Select the desired bank name with [¥] button to allow se-
lection of the memory bank.

(3 Click the [SCAN] button to call up the Scan manager
screen if it is not displayed.

@ Click the [Start mem. scan] button to start memory scan.

(B Make sure the ‘Selected channels only’ check boxes are
checked (v ) for ‘select memory scan’ function.
*When selecting the [Selected channels only] box, only

memory channels specified as SEL (Y) are scanned.
(® To cancel the scan, click [Start mem. scan] again.

% « All settings can be used simultaneously.

7, +SEL is set in the memory list screen.

2-At least 2 memory channels must be programmed with
the desired condition for scan to proceed.

AN\

% Scan manager
1
WalMid
Speed Delay
C 00 [
Fast Slow  Mone 25 5 10k 18: s Stop
Program scan list
PR [START [EMD |75 [WMODE [ATT _ [PAMP [ANT  [COMMENT ii
||
| 002 10MHz  20MHzZ  GKHz AM OFF FAZ | ANTZ BChand

004] 4.0MHz  G.0OMHz 25KHz CW OFF  PAZ |ANT2  Commercial
005 35MHz  3.6MHz 100Hz LSBW | OFF  PAZ |ANT1 | 3.5M band

07 =l

Save | Clear | Stopprog. scan |

temory scan
[r ST |




m Operation

The band scope function allows you to visually check a spec-
ified frequency range. Sweep range varies ‘Very Narrow’
through ‘Very Wide’ with setting of the span steps.

< Scope manager

(D Click the [Band Scope] in the ‘View’ menu to bring up the
‘Scope Manager’ screen.
-Conditions over entire set frequency span can be ob-
served around the center frequency of the current re-
ceived frequency.

(2 Click the [START] button to start (or stop) a sweep.

You can select a displayed signal frequency by clicking the
waveform. The selected frequency is displayed in the center.

< Setting TS and span

The number of (M/K)Hz that the band scope indicates above

and below the center of the receive frequency can be

changed.

Click ‘Span’, then select the sweep width through ‘Very Nar-

row’ (£3 tuning steps) to ‘Very Wide’ (+33 tuning steps).

*Choose ‘Very Narrow’ when band conditions are crowded
(many signals are present); choose ‘Very Wide’ when few
signals are present.

*Span; Very Narrow, TS; 1 KHz

=] B3
14.391MHz

g g
' Scope manager

T51.0kHz

14.937MHz
TS5 | Span | <<

15.0MHz 15.003MHz

> |

*Span; Very Wide TS; 1 KHz

(O]
14.339384MHz

5. g
“: Scope manager

T51.0kHz

14.967MHz
TS | Span | <<

15.0MHz 15.033MHz

» |

BAND SCOPE

< Moving the center frequency

When you find a signal you want to listen to while using the
band scope function, move the mouse over the signal loca-
tion in the Scope manager display and click. The receive fre-
guency moves to that frequency.

In this case, the previously received frequency is displayed
at center after clicking the [START] button .

«Click the displayed signal frequency.

[_[Of =]

o
“% Scope manager

14.985MHz

TS1.0kHz

/

14.9824Hz=
15 | Span | <<

15.0MHz 15.018MHz

53|

6 I

14



15

7 OPTIONS

m Receiver settings

< Send setting data to the receiver

O Push the ‘Write’ button to transfer the 'Receiver settings'
contents to the receiver. All adjusted value will be effective
after the "Write' button has been pushed.

< Read the setting data from the receiver
0 Push the ‘Read’ button to transfer the 'Receiver settings'
contents from the receiver.

Read I Wit I Cloze

< General menu

% Receiver Settings

General | Soundl Displayl

RTTY—————————— RF/S0L Knob Misc
Tone Freg Shift Freg [+ Peak holding
1275Hz & 170Hz  50L mods ¥ Scan resume
¥ Fast scan
" 1B15H la la
z 200Hz Auta mode W fuoTs
& 2125Hz ¢ 425Hz (Ol |

™ Skip blank charnels
¥ Update clock

Fiead I ribe | Close

<O RTTY tone frequency setting
3 tone frequencies and 3 shift frequencies are available.
0 Click to select the desired FSK tone/shift frequencies.

< RF/SQL Knob setting

The [RF/SQL] control can be set as the squelch control (de-
fault), The RF /squelch control or automatic (act as squelch
in FM/AM modes; as RF in SSB/CW/RTTY modes). (p. 7)

< Misc (Miscellaneous)

*Peak holding:
When the peak hold function is ON, the highest activated
segment of the meter remains visible for 0.5 sec.; when
OFF, the meter functions normally.

*Scan resume:
When receiving a signal, scan will pause until the signal
disappears or scan pauses for preprogrammed time.
(p. 12)

e Fast scan:
Sets the searching speed of frequencies or memory chan-
nels to fast.

*Auto TS:
This item sets the auto tuning speed. The main dial nor-
mally changes the frequency [250] x [tuning step]/revolu-
tion. When auto tuning speed is turned on this increases
to [1,250] x [tuning step]/revolution through quick rotation
of the dial.

« Skip blank channels:
Blank channels can be set to be skipped for memory skip
scan. In addition, memory channels can be set to be
skipped for both memory skip scan and full/programmed
scan (frequency skip scan). This is useful to speed up the
scan interval.

«Update clock:

The time data can be transferred from the PC to the re-
ceiver.

< Sound menu

Beeper
Cwf Pitch - High
¥ Fast speech ¥ ME efficiency on AM ESEIEI I :
V| English ¥ AM/S-AM Auta switch ; 500 TE
IV Show signal V' Remate recording .I-E 200 = lLow
¥ Speech clock IV Mute
I Limit
Read Wite I Cloze I

< Speech

Fast speech:
When the optional UT-102 VOICE SYNTHESIZER UNIT is in-
stalled, you can select between faster or slower synth-
sizer.

*English:
When the optional UT-102 VOICE SYNTHESIZER UNIT is in-
stalled, you can select between English and Japanese as
the language.

*Show signal:
When an optional UT-102 SPEECH SYNTHESIZER UNIT is
installed, the synthesizer can be set to read out the fre-
quency/mode only, or both the frequency/mode and S-
meter level.

*Speech clock:
When an optional UT-102 SPEECH SYNTHESIZER UNIT is
installed, the synthesizer can be set to read out the fre-
quency/mode only, or both the frequency/mode and ac-
tual time.

< Sound

*NB efficiency on AM:
When this item is set to ON, the noise blanker function is
available in AM mode. This is useful when communicating
in AM mode (the noise blanker function should not be
used when listening to regular AM broadcasts as it may
degrade the received audio).



OPTION [

. m Port settings
* AM/S-AM Auto switch:

Automatically toggles between normal AM mode and S- See p. 2 'COM (RS-232C) Port settings'.
AM mode depending on the detected audio-signal condi-
tion.

*Remote recording:
This item activates/deactivates the REC REMOTE jack on
the rear panel. When ON is selected, the REC REMOTE
jack is turned on when the squelch opens via the internal
relay.

Turned on. ~

e|Internal connection. I:I _A—o—,

*CW Pitch:
The received CW audio pitch and monitored CW audio
pitch can be adjusted to suit your preferences (300 to 900
Hz) without changing the operating frequency.

< Beeper

*Beeper level:
This item sets the audio level for confirmation beep tones.
The level is selectable from low to high. When ‘mute’ has
been selected, this setting has no effect.

*Beeper mute:
This item can turn off the confirmation beep tones for
silent operation.

*Beeper limit:
This item allows you to set a maximum volume level for
confirmation beep tones. Confirmation beep tones are
linked to the [AF] control until a specified volume level is
reached—further rotation of the [AF] control will not in-
crease the volume of the beep tones.

< Display menu

% Receiver Settin

General | Sound

LCD Backlight

- Light

Read Wit Cloze

*LCD backlight:
This item controls the intensity of the IC-R75's display
backlighting.




Bl 8 TROUBLESHOOTING

If your receiver seems to be malfunctioning, please check the
following points before sending it to a service center.

PROBLEM POSSIBLE CAUSE SOLUTION REF.
No power comes ON. *The RS-232C cable is not connected *Check the RS-232C cable. p.1
correctly.
*The RS-232C port is not selected correctly. Select the RS-232C port correctly. p. 2
No sound comes from the | ¢Volume level is too low. ¢ Click the [VOLUME] control with the sub mouse button | p. 3
speaker. to obtain a suitable level.
*The squelch is closed. ¢ Click the [SQUELCH] control with the main mouse p.3

button or click the [SQL V] button to open the squelch.

Received audio is »The operating mode is not selected correctly. | «Select a suitable operating mode with the mode switch.| p. 3
distorted.

»The IF filter is not selected correctly. «Select a suitable IF filter with [FIL] button. p.3
Sensitivity is low. »The attenuator is activated. «Click the [ATT] button to cancel the function. p.4

All stated specifications are subject to change without
notice or obligation.
17
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